Tools to analyze the organization and formation of the germline cyst in zebrafish oogenesis

Vineet Kumar$^{1,2}$, Yaniv Elkouby$^{1,2,*}$

$^1$Department of Developmental Biology and Cancer Research, The Hebrew University of Jerusalem Faculty of Medicine, Ein- Kerem Campus, Jerusalem, Israel  
$^2$Institute for Medical Research – Israel-Canada (IMRIC), Ein- Kerem Campus, Jerusalem, Israel  

*Corresponding author: yaniv.elkouby@mail.huji.ac.il

Abstract

Oocytes develop in a cellular organization called the germline cyst, in which germ cells are tightly interconnected and surrounded by somatic cells. The cyst produces oocytes for follicle formation and is a hub for essential processes in meiosis and oocyte differentiation. However, the formation and organization of the cyst, and their contribution to oocyte production in vertebrates remain unclear. Here, we provide tools for three-dimensional and functional in-vivo analyses of the germline cyst in the zebrafish ovary. We describe the use of serial block face - scanning electron microscopy (SBF-SEM) to resolve the three-dimensional architecture of cells and organelles in the cyst at ultrastructure resolution. We present a deep learning-based pipeline for high throughput quantitative analysis of three-dimensional confocal datasets of cysts in vivo. We provide a method for laser-ablation of cellular components for manipulating cyst cells in ovaries. These methods will facilitate the investigation of the cyst cellular organization, expand the toolkit for the study of the zebrafish ovary, and advance our understanding of female developmental reproduction. They can be further applied for the investigation of other developmental systems.
Introduction

Oogenesis is a dynamic process that is essential for sexual reproduction. From insects to mammals, early oocytes develop in a cellular organization called the germline cyst, in which germ cells are clustered, interconnected, and are collectively enveloped by somatic cells (Niu and Spradling, 2022). The germline cyst is formed by oocyte mitotic precursor cells called oogonia (Fig. 1A, C). Oogonia undergo several mitotic divisions with incomplete cytokinesis (Fig. 1A), which retains cytoplasmic bridges (CB) with stabilized midbodies between daughter cells (Marlow and Mullins, 2008; Leu and Draper, 2010; Elkouby et al., 2016; Mytlis et al., 2022; Greenbaum et al., 2009). Oogonial incomplete cytokinesis results in cysts with interconnected germ cells. Oocyte differentiation begins with entry into meiosis within the germline cyst, and in zebrafish and mice, oocytes continue to develop in the cyst until leaving it to form the primordial follicle by pachytene stages of meiosis (Reviewed in Elkouby and Mullins, 2017a)(Fig. 1A).

The germline cyst serves as hub for key events in oogenesis. Critical events in meiotic prophase, including the induction of double-strand breaks and chromosomal pairing, occur in the cyst (Elkouby and Mullins, 2017a)(Fig. 1B top panel, see legend for details). A direct connection between the meiosis program and the morphological organization of the cyst was unraveled with our recent identification of the zygotene cilium, an oocyte primary cilium that forms specifically in the germline cyst of zebrafish and mice (Mytlis et al., 2022; Mytlis et al., 2023) (Fig. 1C). Meiotic chromosomal pairing is mechanically controlled by perinuclear microtubules that grow from the centrosome microtubule organizing center (MTOC) (reviewed in Rubin et al., 2020; Kim et al., 2022; Burke, 2018)(see also Fig. 1B). Zygotene cilia connected to the oocyte MTOC machinery and extended extracellularly between oocytes in the cyst (Mytlis et al., 2022)(Fig. 1C). Loss of the zygotene cilium in zebrafish resulted in defected and delayed prophase, as well as in cyst disintegration, and has consequently lead to ovarian dysgenesis and deficient fertility (Mytlis et al., 2022).

In addition to meiosis, the formation of a conserved oocyte organelle, called the Balbiani body (Bb) (Escobar-Aguirre et al., 2017) begins in the cyst (Elkouby et al., 2016) (Fig. 1). The Bb is essential for oocyte polarity and embryonic development in zebrafish (Marlow and Mullins, 2008; Escobar-Aguirre et al., 2017) and is associated with primordial follicle formation in mice (Lei and Spradling, 2016). In zebrafish, Bb formation is initiated in
the cyst when the centrosome MTOC breaks the oocyte symmetry during zygotene stages in prophase (Elkouby et al., 2016) (Fig. 1B, bottom panel). Evidence suggest similar mechanisms that initiate Bb formation in the cyst in mammals and insects (Tworzydlo et al., 2016; Lei and Spradling, 2016). Upstream to symmetry breaking in zebrafish, the last mitotic division in the oogonial cyst was proposed to position the centrosome and align polarization, since during symmetry breaking the centrosome localized adjacent to the CB (Elkouby et al., 2016) (Fig. 1C). These observations suggested a functional link between the cyst organization and oocyte polarity (Elkouby et al., 2016). Altogether, major processes in oogenesis, including meiosis, Bb formation, and oocyte polarity, emphasize potential roles for the cyst organization (Fig. 1C), demonstrating the need for a better understanding of this cellular hub.

Most of our current understanding of the cyst is derived from the Drosophila model. In Drosophila ovaries, oogonia undergo exactly four rounds of mitotic divisions, forming a cyst of 16 cells (Hinnant et al., 2020). Drosophila cyst divisions are synchronous and generate orderly organized cysts with predictable connections between sister cells (Nashchekin et al., 2021). In the Drosophila cyst, only one cell is specified as the oocyte and the remaining 15 function as supporting nurse cells that deliver material through CBs to the oocyte, in a process called dumping (Lu et al., 2017; Quinlan, 2016). Interestingly, a similar dumping mechanism, where nurse-like cells transfer material to a presumptive oocyte, was recently reported in mice (Niu and Spradling, 2022; Lei and Spradling, 2016). However, a variety of cyst organizations exist in nature. The structure of cysts can be represented using cell lineage trees (CLT), where each cell and CB are defined as edge and node of the tree, respectively (Koch and King, 1969; Gondos et al., 1971; Haglund et al., 2011). Varying patterns of cell divisions in different species generate CLTs of distinct sizes and topology.

CLT networks can be categorized in five primary classes (Świątek, 2019) (Diegmiller et al., 2022). In the two-cell network class, an oocyte is connected to a single support cell (termed nurse cell) that transports material to the oocyte, and this class is found in annelid worms (Brubacher and Huebner, 2009), the biting midge (Midge et al., 2020), earwigs (Yamauchi and Yoshitake, 1982; Tachura et al., 2010; Tworzydło et al., 2010) and multiple fungus gnats (R.O. BERRY, 1941; Gutzeit, 1985). In the bilinear chain networks class, cysts are composed of two long strips of support cells emanating from centrally placed oocyte. Such cyst are formed in springtails (class Entognatha) (Matsuzaki, 1973; Biliński, 1983; BILINSKI, 1993), in polychaetous annelid plumed worms (HUEBNER, 1968), the
springtime fairy shrimp (Kubrakiewicz, Adamski and Bilinski, 1991), and net-winged insects (order Neuroptera) (Kubrakiewicz, 1997).

More complex classes are common. In the cytophore ring networks class, cysts are comprised of a ring of cells surrounding a central anucleated cell called a cytophore (Świątek et al., 2009; Urbisz et al., 2017; Świątek et al., 2018; Świątek et al., 2020). In some ring networks, one of the peripheral cells of the ring become the oocyte while the rest become nurse cells. In others, multiple oocytes develop within a single cyst, as in Piscicola geometra (A. Spalek-Wolczyn´ska et al., 2007; Świątek et al., 2009). In the 2^n branched networks class, cysts are formed as a result of synchronous cell divisions, forming symmetric structure, which at each division step comprises of 2^n cells, and where the two most central cells are connected to an equal number of cells. Examples of varying numbers exist. These include 4-cell cyst [n=2 in the scorpion fly (Ramamurty, 1967)], 8-cell cyst [n=3, in whirligig beetles (Matuszewski and Hoser, 1975), Dineutus nigrior (Hegner and Russell, 1916), and the majority of moths and butterflies (Yamauchi and Yoshitake, 1984; F. Marec, 1993)], 16-cell cyst [n =4, e.g., in the oriental fruit fly (Lee, 1985), and winter crane flies (Mazurkiewicz and Kubrakiewicz, 2005), and Drosophila], and 32-cell cyst [n=5, e.g., in the mole flea (Büning and Sohst, 1988) and parasitic wasp (Eastin et al., 2020)].

The last class of cysts is of asymmetric networks (Diegmiller et al., 2022), which form by nonsynchronous cell division. For example, the net-spinning caddisfly forms a 3-cell cyst with an oocyte at one end (Matsuzaki, 1972), and the green lacewing forms a 12-cell cyst (Rousset, 1978). Another category of an asymmetric network is found in Linepithema humile and the bumblebee Bombus terrestris, that form tree-like cysts with numerous long linear branches (Eastin et al., 2020), which do not fit well within any of the class categories.

Considering this high variability of cyst organizations and despite vast mechanistic knowledge from Drosophila, the formation and organization of the cyst in vertebrates, including mammals, is poorly understood. The number of cells in the vertebrate cyst is uncertain. In the mouse, cysts were reported to contain an average of 30 cells (Lei and Spradling, 2013), and cysts break down followed by formation of clonally unrelated clusters from cyst cells (Lei and Spradling, 2013). In Xenopus, cysts contained up to 16 cells (Kloc et al., 2004), whereas Medaka cysts contained up to 30 cells (Nakamura et al., 2010), and in zebrafish the definitive number of cells in the cyst is unknown. In humans, oogonial cells were described to be predominantly found in groups (Kurilo, 1981) or nests (Anderson et al.,
2007) in fetal ovaries. These nests likely represent cysts, or alternatively, nests of smaller clonally unrelated cysts, as was shown in mice (Lei and Spradling, 2013). However, whether they are connected by CBs and the number of cells per nest are unclear. Overall, whether oogonial divisions that construct the cyst are synchronized, what is their pattern of divisions (Fig. 1A), and what is the function of the cyst in vertebrate oogenesis, are unknown.

In zebrafish, the cellular processes of oogenesis and ovarian development are executed and genetically regulated similarly to mammals (reviewed in Elkouby and Mullins, 2017a; Li and Ge, 2020). Due to multiple experimental advantages, the zebrafish ovary is as an excellent model for the study of oogenesis (Elkouby and Mullins, 2017b; Li and Ge, 2020), and the toolbox for the investigation of zebrafish oogenesis has been significantly expanded. Advances in genetics (Jamieson-Lucy et al., 2022; Leerberg et al., 2019; Beer and Draper 2013), quantitative and live ovarian imaging (Mytlis et al., 2022; Mytlis and Elkouby, 2021), live manipulations of cultured ovaries (Deis and Elkouby, 2022), and various proteomic and genomic approaches (Jamieson-Lucy et al., 2022; Liu et al., 2022; Bogoch et al., 2022), have made great impact in the field. Nevertheless, a fundamental understanding of the cyst is still needed. The direct investigation of the germline cyst has been challenged by two technical issues: 1) the thick sample size of the ovary, which restricts the penetration of probes, limiting analyses deep in the tissue, and 2) the limitation of available image processing and automatic segmentation tools in distinguishing between germline cyst cells and their closely surrounding somatic cells.

Here, we provide methodologies and step-by-step protocols for quantitative three-dimensional analyses of the germline cyst in high throughput and in vivo. We describe the use of serial block-face scanning electron microscopy (SBF-SEM) in ovaries and provide methods for segmenting and rendering SBF-SEM data to characterize the spatial organization of the germline cyst in three dimension (3D) and at ultrastructure resolution. We present the implementation of the deep learning algorithms STARDIST (Weigert et al., 2020; Schmidt et al., 2018) and CELLPOSE (Stringer et al., 2021) for the segmentation and analysis of entire germline cysts from 3D ovary image datasets. Finally, we present a methodology to manipulate cyst cells for functional investigation by laser induced ablation of cellular component of interest, using multiphoton microscopy. Altogether, these methodologies will facilitate the systematic and timely investigation of the cyst cellular organization in zebrafish.
results, and can be directly transferred for the investigation of many developmental systems.

Results

Manual segmentation of SBF-SEM in TrackEM2

The state-of-art SBF-SEM technique provides a combination of conventional scanning electron microscopy (SEM) with 3-dimensional image acquisition. In this setup, the sample is embedded in a block and after each scan, a microtome scrapes off a 70 nm thick surface layer of the sample, exposing a new surface for imaging. From multiple iterations of image acquisition and sectioning cycles in a region of interest, 3D images at EM resolution are constructed.

We implemented SBF-SEM to characterize the cellular organization of the germline cyst. 3D datasets of cyst images acquired at EM resolution, were processed by following the our detailed protocol (see Material and Methods), using the TrakEM2 software (Cardona et al., 2012) (Fig. 2). We captured 3 cysts in two regions or interests (ROI) from two ovaries, each spanning over 30 hours of image acquisition. We segmented various cellular components in cysts of leptotene and zygotene stage oocytes, including nuclei, cell membranes, CBs, centrosomes, and zygotene cilia (Mytlis et al., 2022) (n= 30 cells from 3 cysts and 2 ovaries). Segmented labels were then used to generate volume rendering of each component of the germline cyst (Fig. 2A-B). From the generated volume renders we resolved and visualized cell-cell connections, the morphology of cyst cells, and ciliary extension through the cyst, in 3D (Mytlis et al., 2022) (Fig. 2).

We demonstrate here that our SBF-SEM segmentation can also be applied for resolving subcellular organelles in ovaries, including mitochondria, as well as their cellular distribution (Fig. 2C; Movie 1). We previously identified the symmetry-breaking event of the oocyte at the zygotene stage (Elkouby et al., 2016). As detected by confocal and 2-dimensional transmission EM (TEM) images, Bb components, including mitochondria, polarize adjacent to the oocyte centrosome at zygotene stages, but are dispersed randomly in earlier stages (Elkouby et al., 2016). We validated the precise detection of organelles in our pipeline by testing whether it can capture these mitochondria dynamics. Using our pipeline to segment mitochondria and centrosomes, we detected clusters of localized mitochondria...
adjacent to the oocyte centrosomes at zygotene stages (n=24 oocytes; Fig. 2C, right panels), while mitochondria in leptotene stage oocytes appeared dispersed and not specifically enriched adjacent to centrosomes (n=8 oocytes; Fig. 2C, left panel). Our SBF-SEM segmentation thus reliably detects organelles in ovaries and confirms their cellular and developmental dynamics during oocyte polarization in 3D.

Next, we detected intricate and fine cellular and sub-cellular morphology with potential direct functional relevance. Considering that CBs define the cyst organization, we examined their morphology. Examining CBs by confocal analyses requires specific antibodies for CB components that are not easily available in zebrafish, or generation of transgenic lines. Attempting to analyze CBs in thin sections by TEM is challenging because it lacks 3D data to detect entire oocytes or CBs. These challenges are overcome by our SBF-SEM pipeline, and we detected CBs through cysts (Fig. 2D-G). First, we could previously reliably measure the size of the CB, resulting in an average diameter of 567±172 nm (Mytlis et al., 2022).

Second, we asked how many CBs can be detected per oocyte, which can indicate the number of previous divisions, and is unknown in zebrafish. An example for 3D CB detection in a cyst is shown in Fig. 2D and Movie 2. While most oocytes were detected with one or two CBs (n= 22 cells in 3 cysts from 2 ovaries), in two cysts we detected one oocyte with three CBs per cyst (Fig. 2D, Movie 2), indicating that at least one cell in the cyst can undergo three rounds of divisions. While typically for SBF-SEM, this analysis is limited to a small sample size (see discussion), a scenario wherein most oocytes in a cyst contain one or two CBs, and few contains three, best fits the branched network class of cysts, but this remains to be determined. Whether the zebrafish cyst forms by synchronous or asynchronous divisions needs to be addressed by live time-lapse imaging. Nonetheless, this data provides the first indication for the organization of the zebrafish germline cyst as a branched network.

Thirdly, an important feature of the cyst is inter-communication between cells through the CB connections of their cytoplasm. The dumping mechanism in Drosophila transfers material, including mRNA and proteins, from nurse cells to the oocyte through CB ring canals (Quinlan, 2016; Lu et al., 2017) and a similar mechanism was recently proposed in mice (Lei and Spradling, 2016; Niu and Spradling, 2022). However, whether material is
transferred between cyst cells in zebrafish is unknown. We therefore examined the content of CBs in our dataset.

Capturing the entire volume of CBs, we could detect vesicle-like structures in the vicinity of the CBs or in their opening. Fig. 2E-G shows three representative examples of CBs that contain vesicle-like material, as shown by montage images of serial sections, as well as by their 3D segmentation generated by our pipeline. As demonstrated in the 3D segmentation, the vesicle-like material is clearly visible in the CB vicinity and extends into one or both connected oocytes. 88% of CBs contained vesicle-like structures (n=17; Fig. 2H), suggesting that such vesicle-like structures in CBs are common. These presumptive vesicles were detected in consecutive sections through the CB (montage images in Fig. 2E-G), but did not encompass the entire CB diameter (Fig. 2E-G), which can explain why they have been overlooked in 2D TEM analyses. While they have to be confirmed by live time-lapse imaging, these observations suggest the transfer of material between cyst cells for the first time in zebrafish, which can be key for various aspects of oocyte development and/or cyst regulation.

Thus, SBF-SEM and our segmentation pipeline provide a powerful method for analyzing 3D cellular organizations at ultrastructure resolution to comprehensively and accurately decipher sub- and inter-cellular structures of interest. This is a promising approach to identify previously unknown cellular features, as we show here and previously for the zygotene cilium (Mytlis et al., 2022). Generated label images can be further used in ImageJ, for quantitative analysis of physical parameters of cells, including volume, surface area, and additional parameters of interest.

A potential limit of SBF-SEM can be in analyzing a large number of ovaries per sample. SBF-SEM requires long image acquisition, and it can be demanding to identify the correct and complete ROI in the whole tissue, which might require several acquisition attempts. However, once identified and characterized, the novel and unequivocally precise data extracted from SBF-SEM can be studied by more robust imaging approaches like confocal microscopy. To complement SBF-SEM in performing robust analysis of cysts in 3D based on confocal microscopy, we developed the deep-learning based approach below.
Deep learning assisted instance segmentation of nuclei and cells

We established a method for robust analyses of cysts from 3D confocal microscopy datasets. The developing ovary is a complex organ, which contains a variety of cell types, including somatic cells, germline stem cells, mitotic oogonia, and differentiating oocytes at different stages. Furthermore, differentiating oocytes in developing ovaries at these stages range widely in sizes, from oocyte-precursor oogonia, which are 9-11 µm in diameter (Elkouby and Mullins, 2017b; Elkouby et al., 2016), and typically up to ~70 µm oocytes in primary follicles (Elkouby and Mullins, 2017b; Elkouby et al., 2016; Kobayashi et al., 2021). The complexity increases when the size of somatic cells is taken into consideration. Such cellular complexity challenges the application of automatic segmentation algorithms in images, resulting in misidentification of cells and nuclei.

We show here that cellular complexities in the juvenile ovary can be addressed and overcome robustly by using deep learning assisted instance segmentation algorithms with custom models for cell types (Fig. 3; Movies 3-4). Using this approach we executed instance segmentation on high volume of raw dataset in robust and high-throughput manner (Fig. 3A-D), as detailed in our protocols (Materials and Methods). The generated labeled images can be utilized in various analysis pipelines (Fig. 3E). Here, we implement this approach on cysts of various sizes and developmental stages, including mitotic oogonia and meiotic leptotene-zygotene oocytes. The pipeline described in Fig. 3A-E, shows examples of two types of cysts: a 4-cell cyst of oogonia (Fig. 3 top; Movie 3), and a 16-cells cyst of zygotene stage oocytes (Fig. 3 bottom; Movie 4).

We show the 3D segmentation of nuclei and cell cortexes from raw dataset of ovaries (Fig. 3A-E). Cell cortex structures were labeled and detected by three independent manners, including by 1) transgenic expression of Lifeact-GFP (cortical actin) (Fig. 3A), 2) using the phalloidin dye (cortical actin) (Fig. 3F), and 3) immune-staining using the β-Catenin antibody, which labels Adherens junctions on the cortex of cyst oocytes (Elkouby 2016)(Fig. 3G). In all cysts, nuclei were labeled and detected by DAPI (Fig. 3A-D; Movies 3-4). We ran our pipeline on ovaries labeled with each of the above markers, and segmented cell borders and nuclei in 25 cysts of various stages from n=13 ovaries.

Our segmentation detected individual cells in cysts with high accuracy. In some cases, because of the inevitable minimal variability of transgenic expression, dye detection or
antibody staining, the labeling signal was weaker along a cell border. These specific cases of insufficient labeling quality resulted in the false merging of cells in few optical sections. We tested the accuracy in our hands, and manually supervised the calling of cells in cysts. We compared the automated calling to manual calling.

We calculated an accuracy rate where the automated and manual callings were identical per cyst in data from all labels, as well as per cyst and per cell for each label (Fig. 3H). Accuracy rates were 77.3% of cells and 78% of cysts in the LifeAct-GFP labeled ovaries (n=146 cells from 8 cysts; Fig. 3H), 83.5% of cells and 85% of cysts in the phalloidin labeled ovaries (n=207 cells from 9 cysts; Fig. 3H), and 81% of cells and 82% of cysts in the β-Catenin labeled ovaries (n=120 cells from 8 cysts; Fig. 3H). Overall, we calculated 81% accuracy (n=473 cells from 25 cysts and 13 ovaries) of total cell calling from all cell border labels (Fig. 3H, right panel), which is consistent with the accuracy levels originally reported for Cellpose (Stringer et al., 2021). Cases of inaccurate calling in all labels can be very easily supervised by the user. The accuracy of DAPI-based nuclei calling was 78% (n=335 cells in 25 cysts, from 13 ovaries), which is consistent with the accuracy originally reported for StarDist (Weigert et al., 2020; Schmidt et al., 2018). Thus, we were able to achieve the optimal accuracy of labeling in whole ovaries. Further training of these algorithms on ovary samples by their increasing use is expected to increase their accuracy even further.

We next analyzed all accurately called cells. We extracted parameters for cell sizes by volume and surface area, per developmental stage. Oogonia cells showed consistent sizes as labeled by all three markers, of approximately 307 µm$^2$ in surface area and 336 µm$^3$ in volume (left panels in Fig. 3I-J). Leptotene cells showed consistent sizes by all markers of approximately 249 µm$^2$ in surface area and 233 µm$^3$ in volume (middle panels in Fig. 3I-J). Finally, zygotene cells further showed consistent sizes by all markers of approximately 505 µm$^2$ in surface area and 645 µm$^3$ in volume (right panels in Fig. 3I-J).

The extracted characteristic volumes are more accurate than our manual oocyte staging criteria. We previously defined the characteristic size range of each stage, based on molecular markers (Elkouby et al., 2016; Elkouby and Mullins, 2017b; Mytlis et al., 2022). To systematically measure these diameters based on confocal imaging, we inevitably had to assume a spherical shape for oogonia and oocytes. However, oogonia and oocytes in cysts are not shaped as a perfect sphere and vary in morphology, as shown in our SBF-SEM and deep
learning-based 3D segmentation pipelines (Fig. 2-3). Therefore, while our previous manual measures can still distinguish between developmental stages, the automated extracted values are much more accurate, and offer an improved tool to determine developmental stages. We conclude that our pipeline provides a robust, unbiased, and precise tool to measure cellular features of the cyst, and generate reliable data.

This powerful approach can be executed similarly on live imaged ovaries, as well as on ovaries expressing or stained for various cellular markers of interest. Such experiments can be used to extract and analyze additional parameters of cyst cells in the future, like for instance, cell connectivity, by using the newly generated mCherry-Cep55l transgenic line, which labels midbodies (Mytlis et al., 2022). The developed pipeline is robust with many cysts from multiple ovaries being efficiently co-processed and analyzed. Importantly, it can also be extended to detect any cellular feature that can be visualized by confocal microscopy. The only requirement is that the analyzed 3D confocal images will be acquired in good quality, with sufficient signal/noise ratio that can be distinguished by the algorithms for proper segmentation. The segmentation of different features would also require specific training by the algorithm, but this is relatively straightforward to perform.

**Laser-induced ablation of germline cyst cell organelles**

Having established methodologies for characterizing cyst architecture, we next aimed to develop an imaging-based protocol for manipulating cyst cells for functional studies. In functional analysis of cells and cell compartments, addressing phenotypic dynamics in high temporal resolution by genetics can be limited. Laser-induced ablation allows the examination of immediate and highly dynamic phenotypes in real time. We developed a protocol to experimentally manipulate cellular components in live whole mount cultured ovaries while recording and analyzing the effects on cellular dynamics in real time. This protocol is based on and extends our protocols for live time-lapse imaging of cultured ovaries (Elkouby and Mullins, 2017b; Mytlis and Elkouby, 2021; Mytlis et al., 2022), adopting it to multiphoton microscopy (MPM). MPM offers deep penetration, reduced photodamage, minimal invasion over prolonged measurements, and fine laser precision for highly specific ablations.
In this protocol (Materials and Methods), cultured ovaries are mounted in 1% low-melt agarose in a glass bottom culture dish and reinforced with another layer of low-melt agarose to minimize movements (Fig. 4A). On the microscope system, a region of interest (ROI) is located and marked (Fig. 4B, red rectangle). Live imaging parameters were set to 60 sec for pre-ablation recording, followed by stimulation for 30 sec and then post-ablation recording up to 600 sec. The incision laser power at the marked ROI for ablation was set to 2.0-8.0% out of a power source of ~3 Watts.

Using this protocol, we previously manipulated the zygotene cilium in whole mount cultured ovaries (Mytlis et al., 2022) (Fig. 4B). We used ovaries from a double transgenic line [Tg(bact:Arl13b-GFP); Tg(bact:Cetn2-GFP)], which simultaneously visualizes cilia and centrosomes (Borovina et al., 2010; Novorol et al., 2013). Upon laser induced abscission of the zygotene cilium we detected an immediate dislocation of its associated centrosome (Mytlis et al., 2022). Together with other experiments, this allowed us to conclude that the cilium acts to anchor the centrosome in the germline cyst (Mytlis et al., 2022). Thus, this protocol can address questions concerning fine cellular dynamics in real time within developing ovaries, where information from other approaches such as genetics can be limited.

Here, we demonstrate the successful application of our protocol to independently ablate three organelles in cysts within live cultured ovaries (Fig 4B-E). First, we reproducibly demonstrate ciliary excision, and second, we show the utility of the protocol in ablating the oocyte centrosome, as well as the nucleus. To excise the cilium (Fig. 4B; Movie 5), we used the double transgenic line [Tg(bact:Arl13b-GFP); Tg(bact:Cetn2-GFP)] as described above. We marked an ablation ROI (red rectangle ROI) at the base of the cilium (green arrowheads) and away from the centrosome (magenta arrowhead in Fig. 4B; Movie 5). Using the laser power parameters described above has successfully excised the cilium (compare pre- and post-ablation panels in Fig. 4B and in Movie 5), without cellular damage (Movie 4) (Mytlis et al., 2022).

To ablate the oocyte centrosome (Fig 4C, Movie 6), we used ovaries of the single Tg(bact:Cetn2-GFP) transgenic line, which visualizes centrioles. We imaged cysts pre-ablation, ablated a single centrosome (red circle ROI in Fig. 4C left panel, Movie 6) using same parameters as above, and monitored the cyst by subsequent time-lapse imaging for ~10 min, while recording every ~30 seconds (Fig. 4C, Movie 6). To confirm centrosome...
ablation and rule out its translocation to a different position, we imaged a stack of optical sections through the cyst Z axis as shown in the sum-projection images in Fig 4C, which are snapshots from Movie 6. We were able to ablate the selected centrosome specifically, without affecting non-ablated control centrosomes (n=7 centrosomes in 7 cysts, from 4 ovaries). Cysts appeared to remain vital post-ablation and during the course of recording, consistently with our previous experiments (Mytlis et al., 2022).

To ablate the oocyte nucleus (Fig. 4D-E, Movies 7-9), we used ovaries of the Tg(h2a:H2A-GFP) transgenic line, which labels Histone 2A, visualizing nuclei in ovaries. Using the same settings, we ablated a single nucleus (red circle ROI, in Fig 4D-E left panels, Movies 7-9) in cysts, and monitored them by time-lapse imaging, acquiring Z-stacks of cysts images every ~ 60 seconds for 20-40 min (Fig 4D-E, Movies 7-9). We were able to ablate a single nucleus specifically, while the non-ablated control nuclei were unaffected and cysts appeared to remain vital post-ablation and during the course of imaging (n=10 nuclei in 10 cysts, from 7 ovaries). Fig 4D-E and Movies 7-9 show examples of successful ablations of single nuclei in a 2-cell oogonia cyst (Fig. 4D, Movie 7), as well as in meiotic leptotene-zygotene cysts (Fig. 4E, Movies 8-9), demonstrating consistent results in cysts of different cell number and stage.

These experiments demonstrate that our ablation protocol is suitable for ablating different organelles of various cellular and extra-cellular positions in the cyst (cytoplasmic centrosome versus the cell-protruding cilium), as well as sizes (centrosome versus nucleus). This versatility suggests that this protocol can be extended to be efficiently performed in ovaries expressing other transgenic reporters or labeled by vital dyes of interest, for manipulation of other organelles. Our method can thus be utilized to manipulate various cellular components of interest, paving way to numerous possibilities in analyzing cellular developmental dynamics in real time.

Discussion

From insects to mammals, key events in oogenesis are executed in the context of the germline cyst. Deciphering the cellular architecture and functions of the cyst is required for understanding the developmental mechanisms that underly female reproduction, but these
remain unclear in vertebrates. We report powerful protocols for understanding the spatial-temporal development and 3D morphology of the germline cyst in zebrafish, and provide them in reproducible step-by-step protocols.

**Tools for analyzing the germline cyst**

Our protocol for manual segmentation of SBF-SEM in TrackEM2 outlines volume reconstruction from SBF-SEM dataset to visualize the germline cyst (Fig. 2; Movie 1-2). Our protocol utilizes ultrastructural resolution images for generating 3D views of the morphology of the germline cyst, including the intercellular organization of cyst cells and their subcellular structures. This tool provides valuable information for deciphering the cyst functional architecture and dynamics, as we show for the zygotene cilia, for mitochondria sub-cellular distribution during oocyte polarization dynamics (Fig. 2C; Movie 1), and for CB morphology, number (Fig. 2D; Movie 2) and content (Fig. 2E-H).

SBF-SEM is extremely powerful in providing accurate 3D information, which is valuable in unequivocally characterizing and validating features of interest, and in discovering novel ones that have been overlooked by other approaches. However, SBF-SEM can be limiting in the number of samples that can be analysed. The sequential iterative SEM imaging and sectioning in high resolution results in prolonged image acquisition (>30 hours in our hands). It can be demanding to identify the ROI deep in tissues while keeping it intact for imaging, and there is a trade-off between the XY resolution and the ROI size. Notably, in cases where ROIs are adjacent, we were able to maximise a single imaging session to acquire more than one ROI. We recommend combining SBF-SEM with more robust imaging approaches, such as confocal microscopy that enables analyses of high number of samples during functional studies.

Our protocol for deep-learning assisted instance segmentation outlines its implementation for automated detection, labelling and analysis of germline cyst cells and nuclei from ovary 3D image datasets in a high throughput manner (Fig. 3; Movies 3-4). Automatically analysed datasets provided unbiased characteristic features of cyst cells, including their physical parameters such as volume and surface area, and how they change during development. Applying this tool on datasets where additional cellular structures are
visualized by transgenic reporter lines, vital dyes, or by immunostaining, will provide ample information and an unprecedented quantitative understanding of the germline cyst. For example, visualizing the midbody in CBs by a Cep55l transgenic line (Mytlis et al., 2022) will reveal the network of cellular connections in the cyst, from which it will be possible to extract the patterns of divisions that construct the cyst.

This approach can be used to detect any cellular feature that can be visualized by confocal microscopy, given that images are acquired in sufficient quality and by uniform settings as appropriate for quantitative imaging (detailed for ovaries in Elkouby and Mullins, 2017). Analyses of different cellular features would require specific training by the algorithm, which is feasible on conventional computers. In our work, we have reached optimal accuracy in automated identifications of cell borders, as labelled by several markers, as well as of nuclei (Fig. 3), which is consistent with the accuracy originally reported of these algorithms (Schmidt et al., 2018; Weigert et al., 2020; Stringer et al., 2021). We recommend that users will manually supervise the automated analyses to determine the detection accuracy in their systems.

Our protocol for laser-induced ablation of organelles in germline cyst cells outlines a method for laser assisted ablation of sub-cellular features in the germline cyst (Fig. 4; Movies 5-9). This protocol enables the experimental manipulation of cellular components of interest to study their real-time effects on cyst cell development over time. Genetic approaches and data from fixed samples can be limited in providing direct and precise functional information in real time and high resolution. Even sophisticated conditional genetics resulting in tightly controlled mutant or loss-of-function conditions and combined with live imaging can be limited in providing information on rapid and highly dynamic phenotypes. Our protocol for laser-ablation of cellular structures of interest in the zebrafish ovary comprises a complimentary approach to provide exactly this type of information and offers a new tool for functional analyses in the germline cyst.

We demonstrate that this protocol is useful in manipulating cellular organelles of various positions and sizes in cyst cells (Fig. 4B-E; Movies 5-9). The only requirements for this methodology are the use of a multiphoton microscope and the availability of a transgenic line that visualizes cellular features of interest for live imaging. In porting our live culturing protocol of ovaries from our confocal settings to imaging by multiphoton microscopy, we only needed to minimally adjust our mounting set up. When applying our protocol in other
systems, we recommend users to carefully adjust the settings of the ablating laser stimulation according to the tissue, laser wavelength, and ROI. Our reported settings provide an excellent reference point.

The germline cyst and developmental reproduction of zebrafish and humans

The germline cyst is a hub for the production of primordial follicles. Oocytes begin their differentiation and develop in the cyst, from which they are subsequently released to form primordial follicles. Major processes in oocyte differentiation take place in the cyst. For example, the essential events of meiotic prophase, including chromosomal pairing and homologous recombination are executed in the cyst. Importantly, aneuploidy in human eggs is a major cause for miscarriages and infertility, but the mechanistic defects are unknown because we lack a complete understanding of these early stages (Nagaoka et al., 2012; MacLennan et al., 2015; Webster and Schuh, 2017). A direct connection between cyst morphogenesis and chromosomal pairing regulation was revealed by the identification of the zygotene cilium in zebrafish and mice (Mytlis et al., 2022; Mytlis et al., 2023). Thus, characterizing the cyst architecture and formation, and deciphering its regulatory mechanisms is essential for understanding meiotic prophase mechanisms.

In humans, the corresponding stages of oogenesis occur in the developing fetal ovary. At around 10-11 weeks post gestation, oogonia are predominantly found in groups or nests (Kurilo, 1981; Anderson et al., 2007; Farini and De Felici, 2022), which likely represent cysts, or nests of clonally unrelated smaller cysts, as was shown in mice (Lei and Spradling, 2013). During 14-26 weeks post gestation, meiosis is initiated non-synchronously, and mitotic oogonia differentiate and give rise to primordial and primary follicles (Kurilo, 1981; Farini and De Felici, 2022). By weeks 35-40 most oocytes are found in primary follicles (Kurilo, 1981; Farini and De Felici, 2022). Strikingly, ~80% of the initial germ cell pool is cleared by apoptosis before and slightly after birth (Hunter, 2017). A similar clearance of ~80% of the initial pool also occurs around these stages in mice, and while this clearing is thought to represent oocyte culling (Lei and Spradling, 2013; Lei and Spradling, 2016), the underlying mechanism remain unclear. In both humans and mice, the clearance of germ cells by apoptosis, at least partly overlaps with the transition of oocytes from the cyst organization
to forming the primordial and primary follicle. These developmental dynamics strongly suggest that germ cell clearance involves regulation in- and/or by the germline cyst.

Supporting this notion, during oocyte culling, the Balbiani body (Bb) in mice is thought to label oocytes for follicle formation (Lei and Spradling, 2016). It was proposed that the Bb forms in oocytes that are fated to folliculogenesis, and does not form in oocytes fated to apoptosis (Lei and Spradling, 2016). Whether the Bb functionally promotes or simply marks oocyte development remains to be determined. However, in zebrafish and mice, the Bb begins to form in the cyst and matures in the primordial and primary follicles (Elkouby et al., 2016; Lei and Spradling, 2016). Therefore, these observations provide evidence for potential regulation of this critical cell-fate decision in oogenesis through Bb formation and already in the cyst. An alternative, non-mutually exclusive, scenario may be revealed by recent observations in mice that some cyst cells are fated to become nurse cells, and only a few are fated as oocytes (Niu and Spradling, 2022). This mechanism was suggested to involve transfer of material, including Bb components, from nurse-like cells to the oocytes (Niu and Spradling, 2022), which further supports the potential contribution of Bb formation in the cyst to oocyte selection.

In humans, females are born with a finite number of follicles. The convention is that germline stem cells are not maintained or produce oocytes de-novo in the post-natal mammalian ovary (Lesch and Page, 2012). Recent reports suggest the existence of germline stem-like or mitotic germ cells in adult ovaries (Johnson et al., 2004; Eggan et al., 2006; Zou et al., 2009; Pacchiarotti et al., 2010; T.C.A. Kumar, 2011; White et al., 2012), but these remain controversial (Martin et al., 2019). Thus, the above events in the developing ovary, from oogonia to the primary follicle, are extremely crucial since they determine the number and quality of follicles for the entire person’s lifespan. Unfortunately, they are also the most challenging stages to experimentally address in humans, and we lack a fundamental understanding of these early processes and their developmental defects, which cause infertility, reproductive disease, and malignancies.

The zebrafish executes developmental programs of oogenesis and gonad development that are conserved with mammals. The developmental stages, morphological processes, and order of events of oocyte differentiation are similar (rev. in Elkouby and Mullins, 2017a; Li and Ge, 2020), and so are many of the increasingly identified genetic regulators that control different facets of ovarian and oocyte development (Webster et al.,
Additional advantages of the zebrafish model include the high accessibility of developing ovaries that are present in swimming juvenile fish, and the flat and transparent anatomy of the ovary, which is ideal for advanced quantitative and live microscopy, as we demonstrated previously (Elkouby and Mullins, 2017; Elkouby et al., 2016; Mytlis and Elkouby, 2021; Deis and Elkouby, 2022; Mytlis et al., 2022), and in this work. Furthermore, the zebrafish maintains germline stem cells that actively produce oocytes throughout life and in regeneration (Beer and Draper, 2013b; Cao, et al., 2019). While the process of oogenesis is similar to that in mammals, the exception in zebrafish is its capacity to non-synchronously repeat the same process times and times again. As a result, all stages of early oogenesis can be abundantly found in the developing ovary, which enables a holistic view of these processes. In the mouse, oocyte differentiate synchronously, and at any given developmental time frame, a predominant oocyte stage populates the developing ovary. In this sense, the fact that the zebrafish ovary non-synchronously contains mitotic oogonia adjacently to differentiating oocytes at various stages, makes it more similar to the non-synchronous differentiation of oocytes in the developing human ovary (Kurilo, 1981; Farini and De Felici, 2022). Thus, the zebrafish ovary provides as excellent model for understanding the cellular mechanisms that control oogenesis and ovarian development. Specifically, it offers a promising model to identify the overlooked mechanisms that govern the morphogenesis of the germline cyst, with direct relevance for human reproduction.

Altogether the methods described here provide a new toolkit for analysing the germline cyst morphology, organization, and development in early oogenesis in zebrafish. These methods harness cutting-edge tools and serve as a steppingstone to address fundamental long-sought-after questions in oogenesis, with implications generally in cell, developmental, and reproduction biology. Furthermore, they can be ported to other developmental systems in zebrafish as well as other species, contributing to their comprehensive, unbiased, and quantitative understanding.
Materials and Methods

Ethics statement

All animal experiments were supervised by the Hebrew University Authority for Biological Models and were appropriately approved under ethics requests MD-2016222-1, MD-18-15600-2.

Fish lines and gonad collections

Juvenile ovaries were collected from 5–7 week post-fertilization (wpf) juvenile fish. Fish had a standard length (SL) measured according to (Parichy et al., 2009), and were consistently ~10-15 mm. Ovary collection was done as in (Elkouby and Mullins 2017b). Fish lines used in this research are: TU wild type, Tg(β–act:Arl13b-GFP)(Borovina et al., 2010), Tg(β–act:Cetn2-GFP) (Novorol et al., 2013), Tg(h2a:H2A-GFP)(Wilkinson and Shyu, 2001), Tg(β–act:LifeAct-GFP)(Behrndt et al., 2013).

SBF-SEM data segmentation and volume reconstruction

Ovaries were dissected as in (Mytlis and Elkouby, 2021) and embedded in blocks as described (Mytlis et al., 2022). Images were acquired using a Gatan 3View (Gatan, Pleasanton, USA) mounted on a Quanta 250 SEM (FEI, Hillsboro, Oregon, USA). Imaging conditions were as follows; magnification 3400-3500x, pixel size 5.9 nm in x and y, 75nm in z. Images were binned by two giving a final pixel size in x and y of 12nm (Mytlis et al., 2022).

Protocol for Manual Segmentation of SBF-SEM data using TrakEM2

1. Import Image files into Fiji or ImageJ as stack (Fig. 2A, Left panel).

    File > Import > Image Sequence
2. Correct the imported image stack for brightness/contrast and alignment.

   Image > Adjust > Brightness/Contrast

3. Open new TrakEM2 (blank) workspace.

   File > New > TrakEM2 (blank)

4. Select directory for saving TrakEM2 temporary files.

5. In TrakEM2 workspace panel, right-click on empty space, import the image stack.

6. While importing, in Slice Separation dialog box, manually enter the voxel depth and check the box “One Slice Per Layer”.

7. In TrakEM2 organizer panel, select tab Template. Create a new “Area_list” under “Add new child”.

8. Drag and Drop the area_list from Template tab to Project Object tab.

9. In Project Object tab, select the area_list and rename it to intended structure to be segmented.

10. Select the area_list from step 8, under the “Z Space” tab.

11. From TrakEM2 workspace, select the “Brush Tool” and desired size.

12. Draw the contour on structure of interest at alternate slices (Fig. 2A, Middle panel).

13. Once all the slices are marked, fill the empty slices by interpolating the contours.

   Menu > Areas > Interpolate All Gaps

14. Repeat steps 7-13, for all the structures of interest.

15. Export the area lists from TrakEM2 workspace. Set scale to 100.

   Menu > Export > Arealists as labels (tif)
16. Save the exported labels image to local directory.

File > Save as > Tiff

**Protocol for Volume Reconstruction in Imaris**

1. From Imaris Homepage, open the working directory and import the labels in Imaris Arena Tab.
2. Set the voxel size according to the raw image data.
   File > Image Preferences
3. In Surpass Tree Item Menu, select “Create New Surface” tool from Surpass Tree Item Menu.
4. In the Creation dialog box, uncheck “Classify Surfaces” and “Track Surface over time” options.
5. Select “Absolute Intensity” and select area around peak in histogram to segment.
6. Set the desired color and transparency for surface created in step 5 (Fig. 2A, Right panel).
7. Repeat the Steps 3-6 for all surfaces of interest in the labeled image. Save the surface by exporting them as “Scenes”.
8. Import the raw dataset in Surpass workspace and the Surfaces saved in Step 7.
   File > Import Scenes
9. Add “Orthoslicer” from the Surpass Tree Item Menu. Set the slice of choice.
10. Note: Uncheck the “Volume” In Surpass Tree Items, to hide raw dataset.
11. Go to “3D Animation” tab from Surpass workspace menu.
12. Adjust the scene in desired orientation.
13. Add Animation option and total number of frames.
14. Hit “Record”, select the directory for saving the animation (Fig. 2B-G).

**Deep Learning Assisted Instance Segmentation**

Sample preparation for live time-lapse imaging and immuno-staining was previously described (Elkouby and Mullins, 2017b; Mytlis and Elkouby, 2021; Mytlis et al., 2022). Images were acquired on a Zeiss LSM 880 confocal microscope using a 40X lens. The
acquisition setting was set between samples and experiments to: XY resolution=1104x1104 pixels, 12-bit, 2x sampling averaging, pixel dwell time=0.59sec, zoom=0.8X, pinhole adjusted to 1.1μm of Z thickness, increments between images in stacks were 0.53μm, laser power and gain were set in an antibody-dependent manner to 7-11% and 400-650, respectively, and below saturation condition.

Protocol

Setting Up the Working Environment

1. Install Anaconda environment manager (https://www.anaconda.com/)

2. Create a virtual environment in Anaconda

3. Install Jupyter Notebook.

4. Download the Jupyter notebooks for Stardist (https://github.com/stardist/stardist.git) and Cellpose (https://github.com/MouseLand/cellpose.git) from respective github repository.

5. Launch the Anaconda Terminal.

Preparing Training Dataset For StarDist

1. Open the images in Fiji. Using the crop tool, crop region of 256x256 or 128x128.

2. Save the Crop regions in directory named “Training Images”.

3. Open Training Images in Fiji and annotate all the structure of interest using Labkit (Arzt et al., 2022) or TrakEM2 (Cardona et al., 2012).

4. Export and save the labelled Image in directory named “Training Mask”.
Model Training and Predictions

1. From the Anaconda Terminal, activate the respective environment.

2. Launch Jupyter Notebook and browse to the Jupyter notebook downloaded earlier.

3. In the Notebook, Enter the path to “Training Images” and “Training Mask” directories in respective fields.

4. Enter the Model name and directory path to save it.

5. Train the Model until training curve plateaus.

6. Evaluate quality of model by looking at:

   i) Inspection of loss function, the validation loss and training loss curves should converge at the end of training for successful model training. If the validation loss increases with the decrease of training loss, the model is overfitting and training dataset should be increased.

   ii) “Intersection of Union (IOU)”. The closer to 1, the better the performance. (If IOU is less, the training dataset should be increased.)

Once Model is trained it can be further used to make predictions on unseen datasets.

7. Enter the path to unseen datasets in Jupyter Notebook (Fig. 3B). Choose the Custom Model.

8. Run the Program to make predictions on unseen dataset using above created model. (Fig. 3C)

Cell Segmentation using Cellpose

1. Launch new jupyter browser in Cellpose environment using anaconda environment manager.

2. Open Cellpose notebook in Jupyter notebook.
3. Provide directory path for images to be predicted (Fig. 3B) and save results.

4. Choose provided model

5. Set do_3d = True for segmentation done using 3D image or set do_3d = False for 2D segmentation and stitching of labels.


7. Proceed to segmentation.

**Features Extraction from Label Images**

1. Import the predicted label images into Fiji.

2. Set the voxel size to raw data voxel size from properties.

   Fiji > Image > Properties

3. Correct the labels for mis identification using label editor from MorpholibJ plugin (Legland, Arganda-Carreras and Andrey, 2016).

4. Extract the features from the 3D label images using plugin “Analyze Regions 3D” from MorpholibJ (Legland, Arganda-Carreras and Andrey, 2016)(Fig. 3E).

5. Set Glasbey colormap LUT on the predicted label image from LUT menu.

   Fiji > Image > Lookup Tables > Glasbey on Dark

6. Open 3D viewer from Fiji Plugins menu.

   Fiji > Plugins > 3D viewer

7. Select the filename from drop down menu in import dialog box. Import as Volume.


9. Volume reconstruction can also be made by importing the label images in to Imaris Workspace followed by creating surface using “Surface Creation Tool”. (Fig. 3D).
Laser-Induced Ablation of Cyst Cell Organelles

Protocol for ovary mounting and culture

1. Ovaries are isolated as described previously (Elkouby and Mullins, 2017b)(Mytlis et al., 2022). (Fig. 4A1-2)

2. In a glass bottom dish, fill ~150 µl of mounting solution, agarose layer 1. Let it rest until it starts solidifying.

3. Carefully, transfer the ovaries to the mounting solution (agarose layer 1) in the glass bottom dish using forceps (Fig. 4A3).

4. Gently push ovaries to the bottom of the dish and avoid curls (as in (Elkouby and Mullins, 2017c)(Mytlis et al., 2022)). Let it rest until agar solidifies (Fig. 4A3).

5. Once the agar is solidified, add more mounting solution, agarose layer 2, until it covers the solidified mounting solution that contains the ovaries from step 4 (Fig. 4A3).

6. Let it rest for agar to solidify properly.

7. Add adequate volume (~1.5 ml) of HL-15 medium in cell culture dish (Fig. 4A3).

8. Keep mounted ovaries at 28°C.

Reagents and equipment for ovary mounting and culture

1) For ovary dissection see (Mytlis and Elkouby, 2021). Briefly, use a dissecting dish (can be made in-house by casting plastic Petri dishes with animal-proof nontoxic silicone for reusable dishes or 2-3% agarose in Hank’s solution for single-use dishes), Micro-scissors, and Forceps #5. Leave dissected ovaries in a glass 9-well plate at 28 °C until mounting.

2) Hank’s solution (0.137 M NaCl, 5.4 mM KCl, 0.25 mM Na2H PO4, 0.44 mM KH2 PO4, 1.3 mM CaCl2, 1.0 mM Mg SO4, 4.2 mM NaH CO3).

3) 2x L-15, without L-glutamine and phenol red.
4) HL-15 solution (60% Hanks, 40% L-15, 1:100 GlutaMax). Store at 4 °C. L-glutamine is not stable and is added fresh from a stock (GlutaMax).

5) GlutaMax 100X (Gibco #35050-061). Store at RT.

6) 60µ Glass Bottom cell culture dish (ibidi).

7) Low-melt agarose (gelling temperature, 27.4 °C).

8) Mounting Solution A: 1% low-melt agarose in Hank’s Solution. Store at 4 °C.

9) Mounting Solution B: make 500 µl of 490 µl of 2x L-15 (no L-glutamine, no phenol red), 10 µl GlutaMax. This is equivalent to a 2x HL-15 solution. Make fresh and keep at 28 °C.

10) Final Mounting Medium: Agarose layer 1 and 2 are prepared by mixing 500 µl of Mounting Solution A with 500 µl of Mounting Solution B to make a final solution of 0.5% low-melt agarose in 1x HL-15.

Protocol for laser-induced ablation

Laser excisions were performed using a Leica TCS SP8 MP two-photon microscope with a 25X objective and equipped with an incubation chamber set to 28°C.

1. Mount the glass bottom dish with the cultured ovaries on the microscope stage inside the incubator chamber.

2. At 25x Objective, locate the Region of Interest (ROI).

3. At ROI, obtain desired zoomed view of ROI using Digital Zoom and Capture a Live View.

4. Select ROI tools and draw the ROI on above acquired image for ablation.

5. Once the Roi is marked, setup the imaging time parameters as follows:

   1) Pre-ablation timelapse acquisition for 60 seconds.

   2) Laser Stimulation of Roi for 60 seconds at laser power 2.0-8.0% out of a power source of ~3 Watts.

   3) Post-ablation timelapse acquisition for 600 seconds.

6. Repeat the step 2-5 for all the interested sites.
Notes

1. Only one ablation per cyst should be performed to avoid cell and tissue damage.

2. 4-6 wpf ovaries can be mounted in cell culture dish towards the center, leaving enough space for lens to move around.

Software

1. FIJI, for the preprocessing of image datasets and post processing of labelled images.
2. Anaconda, An open-source distribution of Python. Specifically used to maintain dedicated virtual environment with desired versions of python packages installed.
4. Cellpose (Stringer et al., 2021), an anatomical segmentation algorithm written in Python3.
5. Stardist (Weigert et al., 2020)(Schmidt et al., 2018), a deep learning based algorithm for star-convex object detection for 2D and 3D images.
6. Imaris, a commercial microscopy image analysis software.
7. Biorender. Fig 1 was created under license OB24GS6YQ8.

Acknowledgments

We thank A. Beckett, Biomedical EM Unit, at The University of Liverpool, for her help with the SBF-SEM experiments, and Z. Manevich from the Faulty of Medicine Microscopy core and Y. Addadi from the Weizmann Institute core facility for their help with laser ablation experiments.

Author Contribution

Conceptualization, Methodology, and Writing: VK and YME
Investigation and Visualization: VK
Funding acquisition: YME
Supervision: YME
Funding

Israel Science Foundation – grant No. 3291/19, and 558/19 (YME)
HUJI International PhD Talent Scholarship (VK).

Competing interests

Authors declare that they have no competing interests.

Data and materials availability

All data are available in the main text or the supplementary materials.

References


R. 0. BERRY (1941) ‘Chromosome behavior in the germ cells and development of the gonads in Sciara ocellaris’.


Fig. 1. The germline cyst. (A) The germline cyst in early oogenesis. The number, pattern, and synchrony of oogonial divisions that construct the cyst are unknown. The first stages of meiotic prophase (leptotene, zygotene), are executed in the cyst. Oocyte leave the cyst to form the primordial follicle by pachytene stages, and arrest at diplotene in the growing primary follicle. (B) Major processes in meiotic chromosomal pairing and oocyte polarity are executed in the cyst. Top panel: nuclear (blue circle) dynamics of chromosomal (dark red) pairing, in which telomeres are loaded on the nuclear envelop (NE) at the leptotene stage and associate with perinuclear microtubules (not depicted in the figure) via Sun/KASH (LINC) complexes on the NE and the Dynein motor protein. Telomere movement on the NE (sliding on perinuclear microtubules) shuffle chromosomes, driving their homology searches. Telomeres ultimately cluster on the NE apposing the centrosome, forming the chromosomal bouquet configuration, which contributes to chromosomal pairing while oocytes develop in
the cyst. In the follicle, paired chromosomes remain associated via chiasmata through pachytene and diplotene. Bottom panel: dynamics of oocyte polarity and Bb formation. In the cyst: Bb components (green) are randomly distributes in oogonia and polarize for the first time around the centrosome and apposing the telomere (blue) cluster of the bouquet during symmetry breaking at zygotene stages. In the follicle, polarized Bb components form the mature Bb. (C) A cartoon of a germline cyst of oocytes at zygotene stages, that execute the chromosomal bouquet and symmetry breaking events, while oocytes are connected by cytoplasmic bridges (CB) and form the zygotene cilia (red), which extend between them. Centrosomes are localized adjacent to CBs of the last division.
Fig. 2. Three-dimensional reconstruction of the germline cyst from ovary SBF-SEM image datasets. (A) Selected steps from the segmentation protocol. Stacks of images are combined (left), and cellular features of interest are manually annotated (middle) followed by their surface and volume reconstruction (right), showing: the zygotene cilium (maroon), mitochondria (blue), and cytoplasmic membranes (color-coded). Cells in the middle and right panels are color coded. See Movie 1. (B) A general zoomed-out image of volume reconstruction of two adjacent leptotene (blue) and zygotene (green) cysts. (C) Detection of organelle distribution. SBF-SEM segmentation detects mitochondria distribution during
oocyte polarization dynamics. Before symmetry-breaking (left panel, leptotene), mitochondria are randomly distributed in the cytoplasm and not specifically enriched adjacent to centrosome (arrowhead). In contrast, during symmetry-breaking at zygotene stages (two examples are shown: middle, right panels), mitochondria are polarized adjacent to the oocyte centrosome (arrowheads). (D) Detection of CBs in a cyst. Arrowheads point to three CBs that are connected to a single oocyte. See Movie 2. (E-G) CB morphology. Three representative CBs are shown. For each CB, a montage of sequential section images visualizes the CB (light blue), as well as its connected and surrounding cells (segmented in different colors). Vesicle-like material is detected in sequential sections through the CB (arrowheads). 3D reconstruction (right bottom panels) confirms that the vesicle-like material is found and extend through the vicinity of CBs. Scale bars are 1 μm in all panels. (H) The frequency of CBs with and without vesicle-like content (n=17 CBs).
Fig. 3. Deep Learning Assisted Instance Segmentation of the germline cyst in 3D. Raw images of cysts (A) are pre-processed in FIJI for brightness/contrast adjustments (B). Cysts of two stages are shown, Oogonia (top), and zygotene (bottom), expressing transgenic Lifeact-GFP [Tg(βact:LifeAct-GFP); actin on cell cortex, grey] and counterstained for DAPI (blue). The protocol is suitable for other cyst stages and labels for cellular markers of interest. (C) Segmentation - single frame representation of instance segmentations generated by Cellpose (cell cortex, top for each cyst) and Stardist (nuclei, bottom for each cyst). (D) Visualization - three-dimensional volume reconstructions of data from (C) in IMARIS. See Movies 3-4 for steps A-E. (E) Analysis - labels generated in (C) are processed in FIJI for quantification of physical properties like Volume, surface area etc., for statistical analysis in Excel or Python-based data processing pipelines. (F-G) Application of the protocol on cysts from ovaries labeled by the vital dye phalloidin (F; grey; actin on the cell cortex), or by antibody staining for β-Catenin (G; gray; Adherens junctions on cytoplasmic membranes), and DAPI (blue) and DAPI (blue). Panels are raw and labeled images (left), and 3D visualization of automatically segmented nuclei (middle) and cell cortex (right). (H) Plots showing the accuracy of automated segmentation of cells per cyst (left panel, each dot is a cyst), per cyst
and per label from LifeAct, β-Catenin, and phalloidin (middle panel), and per cell and per label (right panel), in which the right bar represents all cells pooled from all labels. (I-J) Sizes of segmented cells at each oogonia, leptotene, and zygotene stages, as extracted from the automated segmentation as in (E), by volume (I), and surface area (J). Note the consistent measures across all labels per stage.
Fig. 4. Laser-Induced Ablation of Cyst Cell Organelles. (A) Ovary dissection and mounting: (1) A 6 wpf juvenile fish (SL=14.5 mm), from which an ovary is dissected (2), and mounted (3). (3) Ovary mounting set up: the ovary is mounted at the bottom of a glass-bottom dish inside two layers of HL-15 media containing low-melt agarose (pink and purple)
and covered with HL-15 media (teal). (B) Ablation live time-lapse setup, showing the excision of the zygotene cilium in ovaries of a double transgenic \([Tg(bact:Arll3b-GFP); Tg(bact:Cetn2-GFP)]\) fish, labeling the centrosome (purple arrowhead) and cilia (green arrowheads). The laser ablation stimulation ROI is at the base of the cilium (red rectangle). The left panel shows the imaging set-up before the beginning of the time-lapse experiment. The middle panel shows the image before ablation (~30 seconds). Ablation is executed for 30 seconds and the time at the end of ablation is defined as 00:00. The right panel shows the excised cilium at ~13 seconds post ablation. Scale bars are 10 μm. Images are snapshots from Movie 5. (C) Ablation of a single centrosome in a cyst using the \(Tg(bact:Cetn2-GFP)\) line and similar settings as in (B). The selected centrosome (red circle ROI in the pre-ablated panel) is specifically ablated (green arrowhead in post-ablation panels), while the non-ablated control centrosomes remain intact. Images are Sum-projections snapshots from Movie 6. Scale bar is 10 μm. (D-E) Ablation of single nuclei in cysts using the \(Tg(h2a:H2A-GFP)\) line and similar settings as in (B), in 2-cell oogonia cyst (D), as well as in meiotic leptotene-zygotene cysts with multiple cells (E). The selected nuclei (red circle ROI in pre-ablation panels) are ablated (green arrowheads in post-ablation panels) while the non-ablated control nuclei remain intact. Images are Sum-projections snapshots from Movies 7-9. Scale bar is 6, and 5 μm, in D and E respectively. (F) A legend for the features shown in panels B-E.
**Movie 1.** Volume Reconstruction of zygotene cyst cells by manual segmentation of three dimensional SBF-SEM imaging data, as shown in Fig. 2. Cytoplasmic membranes (brown and pink), centrosome (green), zygotene cilium (maroon), mitochondria (beige), and nuclei grey are shown.
**Movie 2.** Volume Reconstruction of leptotene cyst cells and their CBs by manual segmentation of three dimensional SBF-SEM imaging data. Cytoplasmic membranes are color coded, CBs are in red.
Movie 3. Volume reconstruction of Oogonia cyst using label images generated by instance segmentation deep-learning algorithms, as shown in Fig. 3A-D.
**Movie 4.** Volume reconstruction of Zygote cyst using label images generated by instance segmentation deep-learning algorithms, as shown in Fig. 3A-D.
Movie 5. Live time-lapse recordings of the laser induced excision of the zygotene cilium shown in Fig. 4B.
Movie 6. Live time-lapse recordings of the laser induced ablation of a single centrosome shown in Fig. 4C.
Movie 7. Live time-lapse recordings of the laser induced ablation of a single nucleus in a 2-cell oogonia cyst shown in Fig. 4D.
Movie 8. Live time-lapse recordings of the laser induced ablation of a single nucleus in meiotic leptotene and zygotene cysts shown in Fig. 4E.

Movie 9. Live time-lapse recordings of the laser induced ablation of a single nucleus in meiotic leptotene and zygotene cysts shown in Fig. 4E.